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SAFETY INSTRUCTIONS

Safety Symbols

This chapter contains important safety instructions
that you should follow when operating the
instrument and when keeping it in storage. Read
the following before any operation to ensure your
safety and to keep the instrument in best condition.

These symbols may appear in this manual or on the instrument.

& WARNING

Warning: Identifies conditions or practices that
could result in injury or loss of life.

& CAUTION

Caution: Identifies conditions or practices that
could result in damage to the instrument or to
other properties.

DANGER: High Voltage

Attention: Refer to the Manual

Protective Conductor Terminal

- [®[> >

Safety Guidelines

Earth (ground) Terminal

General
Guidelines

& CAUTION

o Do not place heavy objects on the instrument.

« Avoid severe impacts or rough handlings that
may damage the instrument.

o Avoid discharges of static electricity onto or
near the instrument.

» Do not insert bare wires or metal objects into
the terminals.

« Do not apply input voltage more than 42V
peak (30Vrms) to the instrument.
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Safety Instructions

Do not perform measurements at a power
generating source or building installation site
(see note below).

The instrument should only be disassembled
by a qualified technician.

(Measurement categories) EN 61010-1:2001 specifies the measurement
categories and their requirements as follows. This instrument falls under
category |. Measurement category IV is for measurement performed at
the source of low-voltage installation. Measurement category Il is for
measurement performed in the building installation. Measurement
category Il is for measurement performed on the circuits directly
connected to the low voltage installation. Measurement category | is for
measurements performed on circuits not directly connected to Mains.

Power Supply

& WARNING

AC Input voltage: 100 to 240V, 50/60Hz

The power supply voltage should not fluctuate
more than 10%.

Always use the AC adaptor included in the
package.

Always connect the AC adaptor to the mains
line first, then to the instrument.

Cleaning the
instrument

Disconnect the power cord before cleaning the
instrument.

Use a soft cloth dampened in a solution of mild
detergent and water. Do not spray liquid into
the instrument.

Do not use chemicals or cleaners containing
harsh products such as benzene, toluene,
xylene, and acetone.

Operation
Environment

Location: Indoor, no direct sunlight, dust free,
most non-conductive pollution (see note below)

Relative Humidity: < 75%
Altitude: <2000m
Temperature: 0°C to 40°C

(Pollution Degree) EN 61010-1:2001 specifies the pollution degrees and
their requirements as follows. This instrument falls under degree 2.
Pollution refers to “addition of foreign matter, solid, liquid, or gaseous
(ionized gases), that may produce a reduction of dielectric strength or
surface resistivity”.

Pollution degree 1: No pollution or only dry, non-conductive pollution
occurs. The pollution has no influence.

Pollution degree 2: Normally only non-conductive pollution occurs.

GUWINSTEK GDS-122 User Manual

Occasionally, however, a temporary conductivity caused by condensation
must be expected.

Pollution degree 3: Conductive pollution occurs, or dry, non-conductive
pollution occurs which becomes conductive due to condensation which
is expected. In such conditions, equipment is normally protected against
exposure to direct sunlight, precipitation, and full wind pressure, but
neither temperature nor humidity is controlled.

Storage ¢ Location: Indoor
environment o Relative Humidity: < 75%

o Temperature: —-10°C to 70°C

Power cord for the United Kingdom

When using the instrument in the United Kingdom, make sure the
power cord meets the following safety instructions.

NOTE: This lead/appliance must only be wired by competent persons

&WARNING: THIS APPLIANCE MUST BE EARTHED
IMPORTANT: The wires in this lead are coloured in accordance with the following code:

Green/ Yellow: Earth
Blue: Neutral
Brown: Live (Phase)

As the colours of the wires in main leads may not correspond with the colours marking identified in
your plug/appliance, proceed as follows:
The wire which is coloured Green & Yellow must be connected to the Earth terminal marked with the

letter E or by the earth symbol @ or coloured Green or Green & Yellow.

The wire which is coloured Blue must be connected to the terminal which is marked with the letter N or
coloured Blue or Black.

The wire which is coloured Brown must be connected to the terminal marked with the letter L or P or
coloured Brown or Red.

If in doubt, consult the instructions provided with the equipment or contact the supplier.

This cable/appliance should be protected by a suitably rated and approved HBC mains fuse: refer to the
rating information on the equipment and/or user instructions for details. As a guide, cable of 0.75mm2
should be protected by a 3A or 5A fuse. Larger conductors would normally require 13A types,
depending on the connection method used.

Any moulded mains connector that requires removal /replacement must be destroyed by removal of any
fuse & fuse carrier and disposed of immediately, as a plug with bared wires is hazardous if a engaged in
live socket. Any re-wiring must be carried out in accordance with the information detailed on this label.
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GETTING STARTED

This chapter gives you an overview of what the
GDS-122 is about, what items are included in the
package, and how the user manual is organized.
After opening the GDS-122 package, check the
contents referring to the Package Contents section,
then learn the features and interface reading the
Main Features and Front Panel and Keys Overview
section. The Manual Overview section gives you
an overall picture of what each chapter is about,
helping you directly jump to the relevant location.
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Package Contents

GDS-122 User Manual

Soft carrying case

GDS-122

AC-DC adaptor

»

Oscilloscope probe x 2 + probe
adjustment tools

\ed

1kHz square wave output cable

. .

Multimeter test lead x 2

Extension module for large
current measurement

Extension module for small
capacitance measurement

USB communication cable

CD-ROM
(software)

User Manual

(this document)

RS-232C communication cable

(optional item - contact Good
will)

10



GYINSTEK

Getting Started

Main Features

Oscilloscope

Dual channel

20MHz bandwidth

100MS/s real-time sampling rate
< 17.5ns rising time

5ns to 5s/div horizontal scale
5mV to 5V/div vertical scale

6k memory points per channel

Isolated inputs between oscilloscope and
multimeter

Autoset function

Trigger mode: Auto, Free run, Single shot,
Edge, Video

2 cursors

5 automatic measurements
4 display image memories
Auto-calibration

Multimeter

Volts, Amps, Ohms, Continuity, Diode,
Capacitance measurement

20A maximum amplitude
True RMS measurement

Isolated inputs between oscilloscope and
multimeter

Common

USB interface

RS-232C interface

1kHz square wave output

3.8 inch color LCD display, 320 x 240 resolution
6 hours running time Li-ion battery

180mm x 113mm x 40mm compact size

690g light weight

11
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Front Panel and Keys Overview

AC adaptor
plug

Display
contrast
switch

F1 - F5 keys

Power
switch

A switch
V switch
R switch

mA
terminal

USB/RS-232C/Square wave port

1 [

GD8-123]

R
i LCD
NN ; display
f LN
OSC OPTION key
+ Arrow keys
A

MENU key +
Up/Down keys

RUN/STOP key
AUTOSET key
DMM/OSC key

Oscilloscope
CH1/CH2
terminal

COM V/Ohm CX
terminal terminal terminal

: Oscilloscope function : Multimeter function

AC adaptor plug

Accepts the AC adaptor cord. DC 8.5V, 1500mA.

USB port

Accepts the USB cable for PC connection.

RS-232C port

Accepts the optional RS-232C cable for PC
connection.

Square wave
output

Outputs a 1kHz square wave for probe
compensation and other general purposes.

LCD display

3.8 inch, 320 x 240 resolution, color LCD display.

OSC OPTION key Sets the following parameters: vertical

+ Arrow keys

level and scale (page22), horizontal level
and scale (page25), trigger level (page25),
and cursor position (page42).

12
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MENU key +
Up/Down keys

Activates the side menu and selects the
menu items.

RUN/STOP key

Manually turns on (run) or off (stop) the
trigger. For details, see page25.

RUN/STOP key

Freezes (stop) or unfreezes (run) the
measurement.

AUTOSET key

Automatically selects the horizontal scale,
vertical scale, and trigger level according
to the input signal. See pagel8 for details.

Switches the measurement mode. For
details, see page87(current),
page85(voltage), and page89(impedance).

DMM/OSC key

Switches the operation mode between the
oscilloscope and multimeter.

CH1/2 terminal

Accepts the CH1 and CH2 input signal.

CX terminal Accepts the test leads for capacitor
measurement.

V/Q terminal Accepts the red lead for voltage, small
capacitance, and impedance
measurements.

COM terminal Accepts the black (ground) lead.

mA terminal Accepts the red lead for current
measurement.

R switch Selects the following measurement:
impedance (page89), diode (page9l),
continuity (page92), capacitance (page93).

V switch Selects voltage measurements (page85).

A switch Selects current measurements (page87).

Power switch

Turns on or off the GDS-122 power.

F1 - F5 keys

Selects the menu item at the bottom of the display.

Disp contrast sw Selects the display contrast.

13
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Manual Overview

Overview This user manual is comprised of seven chapters.
If you want to jump start using the GDS-122, go
directly to the Using Oscilloscope or Using
Multimeter chapter.

Safety The Safety Instructions gives you an overview of

Instructions important safety-related issues which you should

(pageb) be aware of before, during, and after operations.

Getting Started
(page9)

The Getting Started chapter provides you with the
overview of the GDS-122: main features, package
contents, front panel, and user manual (this
section).

Using the The Using the Oscilloscope chapter describes in

Oscilloscope detail how to use the GDS-122’s oscilloscope

(page15) functionalities, including the PC software. The
chapter starts with simple, basic operations
toward more complex measurements and settings.
If you are new to the GDS-122, start with the Basic
Operations section. For advanced users, the Menu
Tree / Shortcuts section shows the menu structures
and all operations shortcuts.

Using the The Using the Multimeter chapter describes how to

Multimeter use the GDS-122’s multimeter functionalities. The

(page83) most commonly used Voltage, Current, and
Resistance sections are listed in the front.

Faq The Faq chapter lists major problems you might

(page9s) encounter during operations and how to fix or

avoid them. Most issues are also listed in the
relevant chapters throughout the document.

Specifications
(page97)

The GDS-122 specifications are separated in
oscilloscope, multimeter, and general parts.

Declaration of

The Declaration of Conformity chapter lists the

conformity safety and EMI/EMC standards to which the GDS-
(page100) 122 conforms.

Index The Index chapter lists most of the keywords used
(pagel01) in this manual in an alphabetical order.

14
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USING THE
OSCILLOSCOPE

This chapter describes the oscilloscope
functionalities in the GDS-122: setting it up and
measuring simple waveforms, using advanced
measurement functions, and configuring the
system settings. The menu tree section at the end
gives you an overview of all functionalities and a
quick access to each of them. For the multimeter
functionalities, see page83.

Basic Operations .. c.ouvieiii i 16
Configurations ...uoeiii i 22
MeaSUIreMENTS .ot anes 39
Advanced VIeWIiNgsS ...oouviiiiiiii i 45
Calibration ..o 51
Saving/Recalling Waves and Settings ..........ccevvievnnnnn. 53
Menu Tree / Operation Shortcuts ........c.oooeviieiiin..... 56
Using the Software......cooiiiiiiiiii e 61
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Basic Operations

Operation flow  The Basic Operations section describes how to set
up the GDS-122 and observe an input signal, step-
by-step.

1. Powering up the GDS-122

Connecting an input signal

Using the Autoset / Introducting the display

- W

Adjusting the scales

5. Adjusting the waveform position

Advanced For more advanced or detailed operations, see the
operations following chapters.

o Configurations (page22)

o Measurements (page39)

o Advanced Viewings (page45)
o Calibrations (pagebl)

1. Powering up the GDS-122

1. Pressing the  Press the power switch. The welcome
power switch screen with the corporate logo
appears on the display.

Maids 1o Maasurs

GDS-122
Handheld (igital Storage Onclloscope & Multimeter

Press any key to continue.

To adjust the display brightness, press =
the switch on the side. The backlight — { i}
turns on and off. =

2. Activating the Press any key (for example the MENU (Example)
oscilloscope  key) to enter the oscilloscope mode.
See the battery level icon at the top left
corner of the display and connect the

16
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power cord if the level is < 25%.

> 75% 75% 50% 25% < 25%

Switching the  If the multimeter screen appears,

operation mode press the DMM/OSC key and change
the mode to oscilloscope.

Tilt standing the Use the bar at the back to
GDS-122 tilt stand the GDS-122 on a
horizontal plane.

Note If pressing the power switch does not turn on the
GDS-122, the battery may need recharging.
Connect the GDS-122 to the AC adaptor and
recharge it for at least 15 minutes.

2. Connecting an input signal

1. Connecting  Connect the probe(s) between the DUT (Device
the probe Under Test) and the CH1/2 inputs on the GDS-122.

Alternately, you may use the
GDS-122's own 1kHz square
L

wave output signal. Insert the
signal cable (included in the
package) to the output terminal.

2. Setting the To prevent excessive input voltage, we
probe recommend you to set the probe attenuation level
attenuation  to the X 10 position to prevent excessive voltage.

17
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=2 _ DUT or
< 53 X1 X10 1kHz square

wave

3. Setting the 1. After attenuating the probe level by x10, you
display also need to magnify the display level by x10
magpnification to match the displayed amplitude with the real

amplitude. Open the CH1 or CH2 SETUP
menu by pressing the MENU key and using
the Up/Down keys.

2. Select the probe attenuation level (10X) by
pressing F3 (Probe) repeatedly. The CH1/CH2
vertical scale indicator at the bottom left corner
of the display changes accordingly.

CH1 SETUP T0X
MENU)—> Prob
CH2 SETUP robe

3. Using the Autoset function

Overview The Autoset function automatically configures the
following parameters according to the input
signal.

« CH1/CH2 on/off

o Vertical scale/level

« Horizontal scale/level
o Trigger level

Using the Press the AUTOSET key. The input

Autoset function signal appears in the best display
condition.

(Continued on next page)

18
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Example
Before After

4. Introducing the display contents

Frequency / 0 000 Trigger status
channel off
Horizontal
S — center
3RS | S-S | RS- | O | - | .- position

J&— Trigger level

Vertical

center =i bcd s e
position S S
- Horizontal
Seccefecesfeceotocect scale
Ab i Base
&Y —CHZ U ; : : : co Vertical
Vertical scale center
position

Trigger status  « Updating the signal (auto mode) ()

o The signal is triggered [ Trig’d |
+ Waiting for trigger conditions (T
o Triggering is stopped

Press the RUN/STOP key to control

trigger on/off (run/stop).

19
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5. Adjusting waveform scales

Selecting the Press the OSC OPTION key
menu repeatedly until the following 5
menu appears on the display. D & (I
<4/ _ Time Base
A /Y _CH1 (or CH2) Volts/Div
'1$F'ET‘iI:'IIE' B‘ﬂ.SE:
AsY —CH1 Uolts/T ;
CH1 Z0m-

Vertical scale Horizontal scale

Adjusting the  Use the Left/Right key to change the horizontal
horizontal scale scale.

Original

Adjusting the  Use the Up/Down key to change the vertical scale.
vertical scale

20
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6. Adjusting waveform positions

Selecting the
menu

Press the OSC OPTION key
repeatedly until the following
menu appears on the display.

<4/ _Time
A /Y _CHI (or CH2) Zero

Horizontal
center

position

Vertical —pt

center
position

Y,
D@L

Adjusting the
horizontal
position

Use the Left/Right key to change the horizontal

position.

Original

Adjusting the

Use the Up/Down key to change the vertical

vertical position position.

Original

21
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Configurations
Overview The configuration chapter describes how to

change various GDS-122 internal parameters for
allowing better measurement condition.

Configuration
items

o Channel (vertical) settings page22
o Horizontal settings page25
o Trigger settings page25
e Acquisition modes page30
« Display settings page36

o System status (only for viewing) page37

Configuring channel (vertical) settings

Overview

The channel settings configure how the waveform
appears in terms of vertical or voltage scale.

Position
Scale

CH on/off
Coupling

Inversion

Magnifica
-tion

Sets the vertical position of the
waveform.

Sets the vertical scale (volts per
graticule). Range: 5mV/div to 5V/div

Turns the channel on or off.

Selects AC or DC coupling. The DC
coupling shows all signal elements,
while the AC coupling filters out the
DC component from the waveform.

Flips the waveform upside down.

Magnifies the displayed units (does not
magnify the real signal). The
magnification function is useful to
align the displayed with probe
attenuation (pagel?), especially X10.

22
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Setting the 1. Press the OSC OPTION key

vertical position repeatedly until the following —
menu appears on the display. D OPTIO (l
< —Time

A /Y _CH]1 (or CH2) Zero

. Use the Up/Down key to change the vertical

position.

Setting the 1.

vertical scale

Press the OSC OPTION key

repeatedly until the following w
menu appears on the display. D(l
</» _Time Base

A/Y _CHI (or2)VoltsDiv. /. \

/P “Tine Base
A¥ —CHZ Ualts/D
CH1 20m- 2

. Use the Up/Down key to change the vertical

scale.

G Original D
IV

Turning the 1.

channel on/off

Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

Press F2 (Channel) repeatedly to turn on or off
the channel.

23
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Q OFF
H1 SETUP

D
CH2 SETUP Channel

0/

Note that when using the Autoset function
(pagel8), channels are automatically turned on or
off.

Selecting the
coupling mode

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

2. Press F1 (Coupling) repeatedly to select DC,
AC, or Ground coupling.

DC
Ground

CH1 SETUP
D
crz seTup | Lcoupling

The DC coupling shows both DC and AC
signal.

qgp
i:

The AC coupling only shows the AC signal.
The Ground coupling shows the ground line.

DC coupling

(center point is at the : : :
bottom due to DC SRR o e
offset) : : '

VU e

AC coupling

(center point is at the : :
middle since the DC |, ,ivvii|iiiiivi,
offset is being : :

removed)

Inverting the
channel

24

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

2. Press F4 (Inverted) to invert the waveform.
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A o
(o ——>
CH2 SETUP Inverted
0/
Invert off Invert on
ey - .

Selecting the 1. Press the MENU key and use the Up/Down
magnification keys to select the CH1(CH2) SETUP menu.

2. Press I3 (Probe) repeatedly to select the probe
magnification ratio.

1000 X
100 X
Q 10 X
@
U @
Configuring horizontal settings
Overview The horizontal settings configure how the
waveform appears in terms of horizontal or time

scale.

Position ~ Sets the horizontal position of the

waveform.
Scale Sets the horizontal scale (time per
graticule). Range: 100ms/s to 10s/s
Setting the 1. Press the OSC OPTION key w
horizontal repeatedly until the following
position menu appears on the display. D(I
Y e A

25

GYINSTEK

GDS-122 User Manual

2. Use the Left/Right key to change the horizontal
position.

Original

Selecting the
horizontal scale

26

1. Press the OSC OPTION key

<4/» _ Time Base

'4;’"E“T‘il:'fle".BﬁSé""é"'
A:Y —CHZ Uolts

repeatedly until the following w
menu appears on the display. )(I

2. Use the Left/Right key to change the horizontal
scale.

Original (I
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Configuring trigger settings: general settings

Overview

The trigger settings configure how the incoming
signal is triggered. The general settings section
describes how to start and stop triggering, adjust
the level, and change the trigger mode.

» For edge triggering details, see page30.
» For video triggering details, see page33.
Status Shows the triggering status in the icon

appearing in the upper right corner of
the display.

Run/Stop Controls starting and stopping the
trigger.

Level Adjusts the vertical and horizontal
level on which the waveforms are
triggered.

Trigger status

The trigger status icon is located at the top right
corner of the display.

The trigger condition is met.

The GDS-122 is showing the input signal
waveform regardless of trigger
condition. Available in the Auto trigger
mode in edge triggering (page30).

The trigger condition is not met, and the
GDS-122 is waiting for the next
condition. Available in the Normal
trigger mode in edge triggering (page30).

g 0 @8

The GDS-122 is showing the input signal
waveform regardless of trigger
condition. The waveform is gradually
updated from the left side of the display.
The GDS-122 automatically switches to
the Scan when the horizontal scale is at
100ms/div or longer.

Triggering is stopped regardless of the
trigger condition. In order to restart

27
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triggering, you have to press the

RUN/STOP key again (in single trigger

mode) or switch to another trigger mode.
Horizontal scale vs. trigger status

S5ns/div 100ms/div 5s/div

==

il

Run/Stop Pressing the Run/Stop key once stops
triggering at most situations and
changes the trigger icon to STOP.
In the single trigger mode in edge triggering
(page30), pressing the RUN/STOP key works as
both activating and deactivating trigger.

Trigger level Press the OSC OPTION key %
repeatedly until the following menu 0
appears on the display.
<4/P _ Time

28

A/V _ Trig

Trigger level indicators

Trigger level
(horizontal)

CHZ OFF ..f 1.000KHZ

Trigger level
(vertical)




GUWINSTEK Using the Oscilloscope

Use the arrow keys to change the triggering
position.

Move the trigger
point up

Move the : : Move the
trigger point trigger point
left right

Move the trigger
point down

Pressing the Up and Down G.F D

key together resets the
vertical trigger level to zero.

Pressing the Left and Right
key together resets the
horizontal trigger level to
Zero.

29
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Configuring trigger settings: edge triggering

Overview The edge trigger type triggers on the incoming
signal edge. Use the edge trigger for all signals
except for video related ones.

o For general trigger settings, see page27.
» For video triggering details, see page33.

To select edge triggering, follow these steps.

1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.

2. Press F1 (Type) to select the Edge trigger type.

Edge
TRIG MODE TYPE

NOP

Slope Selects the slope, rising or falling, on
which the GDS-122 triggers the input
signals.

Source Selects the signal source channel,
CH1 or CH2.

Mode Selects the triggering mode, Auto

(acquires signal continuously),
Normal (acquires signal when trigger
conditions are met), and Single
(manually triggers the signal).

Coupling  Selects the DC or AC coupling and
rejection filters: high frequency or
low frequency.

Selecting the Press F2 (Slope) repeatedly to Rising
trigger slope select the rising or falling slope.
Slope

(Continues to the next page)
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Example: falling edge

Falling edge Triggering point

CHe: OFF _.f 1.000KHZ

Selecting the
source channel

Press F3 (Channel) repeatedly to select CH2
the trigger source channel, CH1 or cHi
CH2. The trigger channel indicator at

the bottom right corner of the display
changes.

Trigger source, ‘
channel

Selecting the
trigger mode

N—r
Press F4 (Mode) repeatedly to select Auto
the trigger mode. The trigger status Normal
icon in the upper right corner of the Single
display changes accordingly. For the
overview of trigger status in general, 7
see page27. )
Auto mode

In the auto mode, input signals are constantly
acquired and shown in the display regardless of
trigger condition.

Horizontal scale (/div) 5ns 100ms 5s

Status icon when not triggered

Status icon when triggered [ Trig’'d ]l Scan |
_AUTO || Scan |

31

GYINSTEK

GDS-122 User Manual

Normal mode

In the normal mode, input signals are shown in
the display only if the trigger condition is met.

Horizontal scale (/div) 5ns 100ms 5s

Status icon when triggered

[ Trig’d il Scan ]
Status icon when not triggeredi (_ Ji(_ )

Single mode

In the single mode, you manually trigger the GDS-
122 by pressing the RUN/STOP key each time you
need to observe the waveform. Once the waveform
is captured, the GDS-122 stops triggering and
waits for the next trigger command.

Horizontal scale (/div) 5ns 100ms 5s

Status icon when triggered

Status icon when not triggered  Scan

Selecting the
coupling mode

32

Press F5 (Coupling) repeatedly to select AC

the trigger coupling. h'; RRJE
J

DC
o DC: triggers on the whole waveform

(AC+DC).
o LF Rjc: filters out the lower

frequency when triggering.

» HF Rjc: filters out the higher
frequency when triggering.

o AC: triggers only on the AC portion
of the waveform.
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Configuring trigger settings: video triggering

Overview

The video trigger type is designed to capture the
video signal format, NTSC, PAL, or SECAM. For
any other signal type, use the edge trigger.

o For general trigger settings, see page27.
» For edge triggering details, see page30.

To select edge triggering, follow these steps.

1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.

2. Press F1 (Type) to select the video trigger type.

Video
TRIG MODE

SOP

Polarity Selects the polarity of
synchronization signal. Normal
means the black level is low. Invert
means the black level is high.

Source Selects the signal source channel,
CHI1 or CH2.

Sync Selects the part of the video signal
used for synchronization: line or
field.

Selecting the
trigger polarity

Press F2 (Polarity) repeatedly to select  Inverted
the polarity of synchronization signal.
o Normal: the black level is low. Polarity
o Inverted: the black level is high.

(Continues to the next page)

33

GYINSTEK

GDS-122 User Manual

Selecting the
source channel

Press F3 (Channel) repeatedly to select CH2
the trigger source channel, CH1 or i
CH2. The trigger channel indicator at
the bottom right corner of the display

changes.

Trigger source ‘
channel

N—

Selecting the
sync

Example

Video line trigger

Press F4 (Polarity) repeatedly to select Field

the synchronization point. T
ine
o Line: the video line is used for
triggering.
o Field: the video field is used for
triggering.

Video field trigger

34
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Selecting the acquisition mode

Overview The acquisition mode specifies how the incoming
analog signal is digitally sampled by the GDS-122.

Sample The waveform data is sampled at an
equal time interval. The sample
mode accurately reconstructs the
waveform, but cannot respond to
rapid changes and sudden peaks.

Peak detect The maximum and minimum data
in the sampling interval are picked
up. The peak detect mode captures
rapid changes and sudden peaks,
but the waveform becomes noisy.

Average Multiple samples are averaged
together. The average mode reduces
the noise level, but the waveform
must be repetitive. The number of
averaging are 4, 16, 64, and 128.

Panel operations 1. Press the MENU key and Q

select the ACQU MODE
menu using the Up/Down @
keys.

2. Select the acquisi- X Peak [
tion mode from F1 Sample | petect | Average
(Sample) to F3
(Average).
For the Average mode, also
press F4 (Averages) repeatedly  |Averages
to select the number of
averaging: 4, 16, 64, or 128.

Example Sample Peak detect Average (16)
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Configuring display settings

Overview The display settings configure how the waveforms
are drawn in the display.

vector drawing The vector drawing mode shows
the waveform as a smooth line,
connecting each data point.

dot drawing  The dot drawing mode shows the
waveform as a collection of
independent data points.

persistence The persistence setting sets how
long the old waveforms remain in
the display, useful for observing
the waveform variations.

Panel operations 1. Press the MENU key and use the Up/Down
keys to select the DISP SET menu.

2. Press F1 (Type) or F2 (Persist) repeatedly to
select vector drawing, dot drawing, and
persistence time.

Infinite
Q Dots 1/2/5 sec
| |
Vectors OFF
@ DISP SET Type ] Persist ]
0/

Vector/dot Vector Dot
drawing example S E B B B E F o

Persistence Persistence off Persistence infinite
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Viewing the system status

Overview The system status menu shows the GDS-122
system settings.

Panel operations 1. Press the MENU key and
select the SYS STAT menu
using the Up/Down keys.

(o) v 5747

2. Select the status menu from F1 (Horizontal) to
F4 (Misc) and press it. The status information
appears in the display.

Trigger I Misc ’
3. To close the system status Q

screen, select different menus

using the MENU key
For details of each item, see the

Horizontal} Vertical

followed by Up/Down keys.

Horizontal status (F1)

HORIZONTAL SYSTEM STATUS

TIME BASE vaIn Tive sase | following pages.
MAIN SCALE 1.0ms . .
WINDOW SCALE 10.us Time base: page25

MAIN POSITION 300.0us
WINDOW POSITION  559.60us
DISPLAY FORMAT YT
ACQUIRE MODE SAMPLE

Main/window scale: page45
Main/window position: page45
Display format: page47 (XY)
Acquire mode: page35

(Continues to the next page)
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Vertical status (F2)

SCALE CH1
SCALE CH2
POSITION CH1
POSITION CH2
COUPLING CH1
COUPLING CH2
PROBE CH1
PROBE CH2

INVERTED CH1
INVERTED CH2

MATH CH1-CH2

VERTICAL SYSTEM STATUS

2.00v

50.0mv

0.00 divs(0.0mv)
0.00 divs(0.0mv)
DC

DC

1X

1X

OFF
OFF

For details of each item, see the
following pages.

CH1/CH2 scale: page22
CH1/CH2 position: page22
CH1/CH2 coupling: page22
CH1/CH2 probe: page22
Math mode: page39
CH1/CH2 invert: page22

—

rigger status (F3): Edge trigger

SOURCE  CH1

TYPE EDGE

SLOPE RISING
TRIGMODE SINGLE TRIGGER

TRIGGER SYSTEM STATUS

For details of each item, see the
following pages.

Trigger type: page30
Trigger source: page30

SOURCE  CH1

TYPE VIDEO

POLARITY NORMAL
SYNC LINE

TRIGGER SYSTEM STATUS

COUPLING DC
Trigger slope: page30
Trigger mode: page30
Trigger coupling: page30
Trigger status (F3): Video trigger

For details of each item, see the
following pages.

Trigger type: page33
Trigger source: page33
Trigger polarity: page33
Trigger sync: page33

Misc status (F4)

MISC

0739002
Ver 3.0

Series Number

38

The Misc status shows the serial
number and firmware version.
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Measurements
Overview The advanced measurement functions allow you
to automatically measure various parameters in a
waveform.
Measurement  « Waveform math page39
items e Automatic measurements page4l
o Time cursor measurement page42
« Voltage cursor measurement page43

Running waveform maths

Overview The waveform math function runs mathematical
operations between CH1 and CH2 waveform, and
then shows the result in the display.

Math type o CHI - CH2 (subtract CH2 from CH1)
o CH2 - CHI1 (subtract CH1 from CH2)
o CHI1 +CH2 (add CH1 and CH?2)
o CH1 * CH2 (multiply CH1 and CH2)
o CH1/CH2 (divide CH1 by CH?2)

Panel operations 1. Make sure that both CH1 and CH2 waveforms
are shown in the display.

2. Press the MENU key and Q
select the WAVE MATH menu

using the Up/Down keys. @@

3. Select the math operation from F1 (CH1 -
CH2) to F5 (CH1 / CH2) and press it.

‘CH] —CH2}CH2—CH1 [cm +CH2]CH] *CHZ[CH] /CHZ]

4. The math result appears in the display
(example: adding two square waveforms)

39
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Uk 31.75mv [ 1.000KHZ

To cancel the math result, press the function
key (F1 to F5) again.

Changing the 1.

math result
position

Press the OSC OPTION key. %
0

Make sure the following menu
appears on the display.
A/ _CHM Zero i 2ALE

CH1 5.00%- CHZ 50.Cwe—

Use the arrow keystomove the  \ [ /

math result position. D (I

Changing the 1.

math result scale

Press the OSC OPTION key
repeatedly until the following 0
menu appears on the display.

<4/P _ Time Base

A/V _CHMath
Volts/Div

Use the arrow keys to change

the math result scale. D (I

Saving or The math result waveform can be saved into or
recalling the recalled from one of the four GDS-122 internal
math result memories. See page53 for details.
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Running automatic measurements

Overview The automatic measurement function measures
the input signal’s characteristics and lists them in
the top left corner of the display.

Source signal CH1, CH2

Measurement set SET1, SET2

Measurement  The following measurement items are available.
items o Frequency

o Period

o Mean voltage

o Peak-to-peak voltage

o Cycle voltage (true RMS)

Panel operations 1. Make sure that the waveform appears.

2. Press the MENU key and

select the MEAS SET1 or Q
SET2 menu using the

Up/Down keys. SET1 and U
SET?2 correspond to the

results in the upper left
corner of the display.

MEAS SET1 MEAS SET2
| |

Lo 4y CHE SETU
B Lo M—— MEAS SET1

"""" MEAS SET2

CH 1
| Period | Mean | FE-FR | Cyc FM3 |
L Measurement items—J

3. Select the measurement type from F1 (Freq) to

41
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F5 (Cyc). Press it repeatedly to select CH1 or 2.

Top left__
corner | T Y le Vlk

[ Freq I Period I Mean I PK-PK ICyc RMS]

The measurement result appears in the top left
corner of the display.

Running time cursor measurements

Overview The time cursor function measures and updates
the following three types of time difference.

Between cursor 1 and cursor 2
Between cursor 1 and center (zero) point
Between cursor 2 and center (zero) point

Time cursor 1.

panel operations

Make sure that the waveform appears.

2. Press the MENU key and Q

42

select the CURS MEAS menu

using the Up/Down keys. @

Press F1 (Type) repeatedly to
select the Time cursor. The Type

cursors appear as vertical
purple lines located at the
center of the display.

Press the OSC OPTION key
repeatedly until the following “\QPTIO

menu appears.
<4/P» - Time
A/VY _Cursor 1(or 2)

A STime
A/Y —Cupsor 1
CH1 5.00%—

CHZ 50, O

Use the arrow keys to move the cursor or
horizontal position.
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Move the
cursor left
Move the : : Move the
horizontal horizontal
position right position left
Move the

cursor right

H i T1 TO T2
Display overview Cursor (center) Cursor
(CHT1, cursor 2)

CHZ OFF |f 1.008{HZ Trig'd

T2 - TO time
T1 -TO time
T1 -T2 time

& frequency
Cursor menu

Running voltage cursor measurements

Overview The voltage cursor function measures and updates
the following five types of voltage difference.

» Between cursor 1 and cursor 2

o Between cursor 1 and CHI1 center point
» Between cursor 2 and CH1 center point
o Between cursor 1 and CH2 center point
» Between cursor 2 and CH2 center point

Source signal CH1 input, CH2 input

Voltage cursor 1. Make sure the waveform appears.

anel operations
P P 2. Press the MENU key and Q

select the CURS MEAS menu

using the Up/Down keys. @
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3. Press F1 (Type) repeatedly to
select the Voltage cursor. The [_Type

cursors appear as horizontal
purple lines located at the
center of the display.

4. Press F2 (Source) repeatedly
to select the source channel. Source

5. Press the OSC OPTION key %
repeatedly until the following 0
menu appears.

<4/» _Time
A/V _Cursor V1 (or V2)

6. Use the arrow keys to move the cursor or
horizontal position.

Move the
cursor up
Move the Move the
horizontal 05 horizontal
position right O position left
Move the

cursor down

Display overview Vi V2
splay overvie Cursor Cursor
(CH1, cursor 2)

CHZ OFF |f 1.0€0KHZ

V2 - center
V1 - center
V1 - V2|

Cursor menu

44
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Advanced Viewings

Overview The advanced viewing functions allow you to
clearly observe specific type of waveforms and/or
particular characteristics in a waveform.

Viewing items  « Waveform zoom page45
o X-Y format paged?7
» Signal peaks page48
« Noisy signals page48
o Variations in a signal page49

Zooming waveforms horizontally

Overview By using the zoom function, you can magnify the
waveform in the horizontal direction.

Panel operations 1. Make sure that the waveform appears in the
display.

2. Press the MENU key and Q
select the TIME MODE menu

using the Up/Down keys. @

3. Press F2 (Set Window). A set
of cursors appears in the Window
center of the display.

Zoom window
CHZ OFF _f 1.000KHZ

45
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4. Press the OSC OPTION key %
repeatedly until the Time 0

Base menu appears.

<4/ _Time 7w “Time Base ! D
A7¥ —CH1 Volts Div:

A/V _Cursor V! EENCEEETT

(or Cursor V2)

5. Use the arrow keys to change the zoom width.

Zoom out
vertical scale

Narrow range D 0sC (l Wide range
OPTIO

Zoom in
vertical scale

6. Press F3 (Window) to zoom :
. . Window
into the window.

Example

CHZ OFF |f 1.000KHZ CHZ OFF |f 1.000KHZ
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Viewing waveforms in X-Y format

Overview

The X-Y format plots the CH1 input as X-axis and
CH2 input as Y-axis. This display mode is
convenient for viewing the phase relationship
between CH1 and CH2.

Panel operations

1. Make sure that both CH1 and CH2 waveforms
appear in the display.

2. Press the MENU key and Q

select the DISP SET menu

using the Up/Down keys. @
3. Press F3 (Format) and select
XY. The display mode Format

switches into the X-Y format.

Changing the
scale and
position

Press the OSC OPTION key
repeatedly to access the menu listed g
0

below. In the X-Y mode, all scales and $

positions are controlled by the
Up/Down keys. D

o CH1 Zero: horizontal position
o CH2 Zero: vertical position

« CH1 Vol: horizontal scale

« CH2 Vol: vertical scale

Functions not
applicable in the
X-Y format

The following functions do not work in the X-Y
format.

o Cursor measurement (page42, page43)
e Automatic measurement (page41)

»  Window zoom (page45)

o Trigger settings configuration (page25)

GYINSTEK
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Viewing signal peaks

Overview

Using the peak detect acquisition mode, the
maximum and minimum data in the sampling
interval are displayed, capturing the rapid
changes and sudden peaks that might
spontaneously occur in a waveform.

Note

Since the peak detect mode picks up the most
extreme data, the waveform becomes noisier than
the normal acquisition mode (sampling mode).

Panel operations

1. Press the MENU key and use the Up/Down
keys to select ACQU MODE menu.

2. Press F2 (Peak Detect) to activate the peak
detect mode.

Peak
ACQU MODE|

For other acquisition settings details, see page30.

SOP

Example

Peak detect off

Peak detect on

F . ¥ - . i ! g & . F E £ £ E E .' £ £ E
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Viewing noisy signals

Overview Using the Average acquisition mode, you can
smooth out the displayed waveform by averaging
multiple data samples. The number of averaging is
selectable from 4, 16, 64, and 128.

Note + Inorder for the average mode to work in the
best way, the waveform must be repetitive.

o As the number of averaging increases, the
slower the waveform update becomes.

Panel operations 1. Press the MENU key and use the Up/Down
keys to select ACQU MODE menu.

2. Press F3 (Average) to activate the average
mode.

3. Press F4 (Averages) repeatedly to select the
number of averaging.

4

128
Q 64

|

16
@ ACQU MODE Average {Averages
N

For other acquisition settings details, see page30.

Example

Average off Average 16
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Viewing variations in a signal

Overview Using the persistence display function, you can
define sets how long the old waveforms remain in
the display, allowing observation of waveform
variations. You can select the persistence time
from 1, 2, and 5 sec. When choosing the Infinite
mode, the GDS-122 keeps all past traces of the
displayed waveform.

Panel operations 1. Press the MENU key and use the Up/Down
keys to select DISP SET menu.

2. Press F2 (Persist) repeatedly to select the
persistence time.

Infinite
1/2/5 sec

OFF
DISP SET

For other display settings details, see page36.

SOP

Example

Persistence off Persistence infinite

f 1.117KHZ | CHZ OFF

| CHZ OFF

CH1 -0.04 divs(-Z:0my)

- LEFT/RIGHT ~Tine Bagg -~ -
UE/DOUN ~CHL Yol = . o
CHL 50.0mse~ CHZ 100w
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Calibration

Overview

The self calibration automatically adjusts the GDS-
122 internal parameters. The probe calibration
adjusts the probe capacitance. You should run
both whenever using the GDS-122 in a new
environment.

Running the self calibration

Overview

The self calibration function automatically
configures internal parameters to maintain the
sensitivity and accuracy. Run the self calibration in
the following cases.

« When the temperature fluctuates more than 5
degrees Celsius during operations

o  When operating the GDS-122 in a new
benchtop or field environment

Procedure

1. Press the MENU key and Q

select the FUNCTION menu
(o)

using the Up/Down keys.

2. Press F2 (Autocalibration). A
message appears on the libration
display, asking you to remove
all cables and probes from the

GDS-122.

3. After removing all cables,
press F2 (Autocalibration) libration
again. The self-calibration

automatically starts and a
message appears, showing
that the calibration is
ongoing.

4. When the message disappears in 5 minutes, the
calibration is completed.

To interrupt
calibration

Press any key during the calibration.
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Running the probe calibration

Overview

The attached probe contains a calibration point at
the end to adjust the waveform.

Procedure

52

1kHz square wave output
signal. Insert the signal cable
(included in the package) to the

1. You may use the GDS-122’s own M
output terminal. !

2. Use the Autoset function to put

the waveform in the middle of
the display.

f 1.005KHZ f 1.005KHZ
R TRIG NODH]

At

3. Adjust the probe calibration point to make sure
that the waveform edge remains flat.

Over- Optimum Under-
compensation compensation
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Saving/Recalling Waves and Settings

Overview The GDS-122 can save or recall four sets of
waveforms using its internal memory. When you
need to reset the system, recall the default (factory
installed) settings.

Save/recall items « Recalling default settings pageb3
o Saving waveforms pageb4
o Recalling waveforms page55

Recalling the default settings

Recalling the
default settings

You can recall the default factory settings by
pressing the MENU key, then selecting
FUNCTION — F1 (Recall Factory).

Recall
(o) (e
v (FD)

Trigger Type: Edge Slope: Rising
Source: CH1 Mode: Auto
Coupling: AC

CH1 & CH2 Coupling: AC Channel: ON
Probe scaling: 1 X Invert: OFF

Measurement 1 Item: CH1 frequency

Measurement 2 Item: CH2 frequency

Cursor Cursor: OFF Channel: CH1

Acquisition Mode: Sample Average number: 16

Time mode Mode: Main timebase

Display Type: Vector Persistence: OFF
Format: YT Carry: Bitmap

Wave Save Source: CH1 Waveform: A

Display: OFF
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Saving waveforms

Overview Up to four waveforms can be stored in and
recalled from the GDS-122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

Memory Four memories: waveform A, B, C, and D.

Source CH1, CH2, Math waveform

Panel operations

54

1. Make sure the waveform you want to save
(CH1, CH2, or Math result) appears in the
display.

For Math operations details, see page39.

2. Press the MENU key and Q
select the WAVE SAVE menu
using the Up/Down keys. @

WAVE SAVE

3. Press F1 (Source) repeatedly CH1
and select the waveform Source
source.

4. Press F2 (WAVE) repeatedly A
and select the memory Wave
location from A to D.

5. Press F3 (Save) to confirm Save
saving the waveform into the

e

specified memory location. 3
Make sure that the message
“WAVE SAVED” appears in

the display.
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Recalling waveforms

Overview Up to four waveforms can be stored in and
recalled from the GDS-122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

Memory Four memories: waveform A, B, C, and D.

Source CH1, CH2, Math waveform

Panel operations 1. Press the MENU key and
select the WAVE SAVE menu

using the Up/Down keys. @

2. Press F2 (Wave) repeatedly
and select the waveform you Wave

want to recall.
3. Press F4 to turn on the

waveform. The waveform Show

appears in the display.

CHZ OFF | CH1 OFF

CHL 2.00w- C i
CHL OFF [y

Note The recalled waveform maintains its original
horizontal scale and vertical scale, which are
shown in the top left corner of the display.
Changing the current scale does not affect the
recalled waveform'’s shape.
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Menu Tree / Operation Shortcuts

Accessing The following menu trees are Q
menus accessible by pressing the MENU

key followed by Up/Down keys,
except for the OSC OPTION key

(=9
(page60). v

Trigger

AC
Auto LF Rjc
Rising CH2 Normal HF Rjc
| | | |

Edge Falling CH1 Single DC
TRIG MODE TYPE [ Slope ] Source] Mode |Coupling

Inverted CH2 Field
] ] ]
Video Normal CH1 Line
TYPE Polarity | Source Sync
Select run or stop mode RUN/STOP key
Select edge or video trigger TRIG MODE—FI1(TYPE)
Select trigger slope TRIG MODE—F1(edge)—F2(Slope)
Select trigger source TRIG MODE—F1—F3(Source)
Select trigger mode TRIG MODE—F1(edge)—F4(Mode)
Select trigger coupling TRIG MODE—F1(edge)—F5(Coupling)
Select video polarity TRIG MODE—F1(video)—F2(Polarity)
Select video line sync TRIG MODE—F1(video)—F4(Sync)

CH1/CH2 Setup

1 X
CH1 SETUP DC 100000X
Ground OFF 10 X ON
| I ' '
AC ON 1X OFF
CH2 SETUP Coupling [ Channel | Probe ] Inverted

Select AC, DC, or Ground coupling CH1/2 SETUP—F1(Coupling)
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Turn CH1 on or off

CH1/2 SETUP—F2(Channel)

Select probe scaling

CH1/2 SETUP—F3(Probe)

Turn inversion on or off

CH1/2 SETUP—F4(Inverted)

Measurement Setup 1/2

CH2 CH2

CH1 CH1
| |

MEAS SET1

CH2 CH2 CH2

CH1 CH1 CH1
| | |

MEAS SET2 Freq | Period

Mean [ PK-PK ]Cyc RMS]

Measure CH1/CH2 frequency

MEAS SET1/2—F1(Freq)

Measure CH1/CH2 period

MEAS SET1/2—F2(Period)

GYINSTEK
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Acquisition Mode

4
128
64
|

Peak 16
ACQU MODE Sample [ Detect ] Average ]Averages]

Select sampling mode ACQU MODE—F1(Sample)

Select peak detect mode ACQU MODE—F2(Peak Detect)

Select average mode ACQU MODE—F3(Average)

Select average number ACQU MODE—F3—F4(Averages)

Measure CH1/CH2 mean value

MEAS SET1/2—F3(Mean)

Measure CH1/CH2 peak to peak time

MEAS SET1/2—F4(PK-PK)

Measure CH1/CH2 cycle

MEAS SET1/2—F5(Cyc RMS)

Wave Math

WAVE MATHI—chi1 —CH2’CH2—CH1 ’cm +CH2{CH1 *CHZJCH] /CH2’

Time Mode

Main Zone .
TIME MODE TimeBase[ Window [ Window ’

Select main timebase TIME MODE—F1(Main TimeBase)

Set window zoom width TIME MODE—F2(Zone Window)

Zoom window TIME MODE—F3(Window)

Subtract CH2 from CH1

WAVE MATH—F1(CH1-CH?2)

Subtract CH1 from CH2

WAVE MATH—F2(CH2-CH1)

Function

Add CH2 to CH1

WAVE MATH—F3(CH1+CH?2)

Multiply CH2 with CH1

WAVE MATH—F4(CH1*CH2)

Divide CH1 by CH2

WAVE MATH—F5(CH1/CH2)

Cursor Measurement

Recall | Autoca-
FUNCTION Factory [Iibration

Recall factory settings FUNCTION—F1(Recall Factory)

Run self calibration FUNCTION—F2(Autocalibration)

Time
Voltage CH2
1 1

CURS MEAS OFF CH1
Type Source

Display

Activate cursor measurement

CURS MEAS—F1(Type)

Select source channel

CURS MEAS—F2(Source)
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Infinite
5 sec
2 sec
Dcl)ts 1 sec XY Vecltors

| |
Vectors
DISP SET Type

OFF ] YT Bitmap

Persist | Format Carry
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Select line display

DISP SET—F1(Type)

Select persistency

DISP SET—F2(Persist)

Select display format

Select display save format

(
(
DISP SET—F3(Format)
DISP SET—F4(Carry)

Wave Save

Math
CH2
|

D
C
B

ON
]

CHI1
WAVE SAVE Source l Wave

]
A

OFF
{ Save [ Show ]

Select source channel

WAVE SAVE—F1(Source)

Select waveform 1D

WAVE SAVE—F2(Wave)

Save waveform

WAVE SAVE—F3(Save)

Turn waveform display on or off

WAVE SAVE—F4(Show)

System Status
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OSC OPTION key

UP Press the OSC OPTION key repeatedly. The
menu message appears in the lower half of

the display and the functionalities of four
LEFTD.GR'GHT keys, UP, DOWN, RIGHT, LEFT, change
accordmgly
DOW“ E LEFT/RIGHT ~Tine Base-
AF/DOMN CHY Vol 5.0

—

Horizontal

SYS STAT—F1(Horizontal)
SYS STAT—F2(Vertical)

Vertical [Trigger { Misc ]

Show horizontal settings

LEFT/RIGHT - Time Base
UP/DOWN - CH1 Volts\Div />

LEFT/RIGHT - Ti . : e

0p /D/OWN ! CH']"‘Z‘ZrO <«/» . CH1/CH?2 horizontal position
J, A/ V' CH1 vertical position

0P DOWN ~ CHo vere4/P>: CH1/CH2 horizontal position
J/ A/ V. CH?2 vertical position

LEFT/RIGHT - Ti

UP/D/OWN - Triéme <4/». CH1/CH2 horizontal position
J/ A/V. Trigger vertical position

: horizontal scale

J, A/V.

CH1 vertical scale

Show vertical settings

Show trigger settings

SYS STAT—F3(Trigger)

Show serial number

SYS STAT—F4(Misc)

59

LEFT/RIGHT - Time Base
UP/DOWN - CH2 Volts/Div </>‘ horizontal scale

;) A/ V. CH2 vertical scale

(Math mode) (Math mode)

<4/» - Time <«/P: Math horizontal position
A/YV _CHMath A/ V¥ : Math vertical position
Volts/Div

(Cursor mode)
<4/» _ Time

A/VY _cCursor1/2

(Cursor mode)
</ CH1/CH2 horizontal position
A/ V: Cursor 1/2 vertical position
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Using the Software

Overview

The GDS-122 PC software, included in the CD-
ROM, allows you to view the waveforms in your
familiar PC environment — large display and
mouse operation. Multiple cursors provide flexible
waveform measurements.

Software
functionalities

The PC software can run the following
measurement and actions.

» Viewing real-time updated waveforms

o Running up to 6 cursor measurements

o Measuring period/frequency/pk-pk voltage
o Printing out waveform images

o Saving and recalling waveform shape and data

Software The following is the list of software operations
operations described in this chapter.
o Installing the software page62
» Modifying, reinstalling, or page64
uninstalling the software
o Connecting the GDS-122 page65
« Configuring the screen page68
o Viewing waveforms page69
e Measuring waveforms page75
» Saving waveforms page75
+ Recalling waveforms page77
o Printing out waveforms page80
o Accessing the Help page82
Note The PC software is intended for oscilloscope

operations only; it does not include multimeter
operations.
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Installing the software

PC requirements e
L]

Windows 2000 or XP
20MB hard drive space
USB host port x 1

Installation steps 1.

62

Activate the Setup.exe file in the @
CD-ROM. 3

setup.exe

The language selection window appears. Select
the software language and click OK (you can
later change the language manually).

English Simplified Chinese

Ok I Cancel |

The software starts preparing the installation.
When the welcome window is displayed, click
Next and start installing the software to your
PC.

Welcome to the InstallShield Wizard for
DS_Wave

The InstalshieldR) Wizard wil alow you to modify, repair, or
remove DS_Wave. To continue, click Next.

= Bl

Cancel | |

The customer information window will appear.
Enter the user name and organization name.
Select which user will hold the right to access
the software and click Next.
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Customer Information E N

Flesse enter your nfermaton,

‘_—‘—.

Usar hlame:

J505- 122 User

> User Name

If‘.der Wil Irestruments |

> Organization

ation lor:

 anyone who uses this computer (all usars)

& Griy for me () Administration

5. Change the installation directory if necessary
and click Next.

Destination Folder

Click Mext to install to this folder, or click Change to install to a different folder,

G Instal DS_Wave to:
C:¥Program Files¥GoodWil¥GDSs-122¥

"ﬁ—-

< Back | [Mext > | Cancel | |

6. Click Install to start installing the software.

— IhstallShie

Ready to Install the Program ‘

The wizard is ready to begin instalation.

"ﬁ-—

Click Install to begin the installation.

If you want to review or change ary of your instalation settings, click Back. Click Cancel
o exit the wizard,

< Back I Install ZI Cancel | |

7. The software installation automatically starts
and ends. Click Finish to complete installation.

InstallShield Wizard Completed

The InstalShield Wizard has successfully installed DS_Wave.
Click Finish to exdt: the wizard.

= Back Einish

iz | |

Installing the software is completed
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Modifying/Reinstalling/Uninstalling the software

Overview After installing the software, you can do the
followings using the same setup file.

o Modifying the software components
» Repairing the software
¢ Uninstalling the software
Steps 1. Activate the Setup.exe. Follow g
the same procedures as y
installing the software until the setunexe

Program Maintenance window
appears.

Program Maintenance ‘

Modify, repair, or remove the program.

‘*—

Change which program feafres are instaled. This optien displays the
@ Custom Selection dialog in which you can change the way features are
installed.

 Repair

Repair instalation errors in the program. This option fices missing or
cormnupt fies, shortouts, and registry entries,

" Remove

@ Remove DS_Wave from your computer.
C]

IsrAlsHEl]

< Back I [ext > I Cancel

2. Select the action — Modify the software
components, Repair the software, or Remove
(uninstall) the software — and click Next.
Proceed according to the instructions.

Shortcut for Alternatively, you can select the Uninstall
uninstall DC_Wave from the program startup menu to
uninstall the software.

+ 1;2”:3] DE Wave exe

] USBDRV Install
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Activating the software and connecting the GDS-122

Overview

Activate the software and connect the GDS-122 to

it properly by going through these steps,
described in the paragraphs that follow.

1.

Activating the software and configuring the
communication port

. Activating the GDS-122 and configuring the

data format

Connecting them together and if necessary,
installing the USB driver

. Acquiring waveform data to confirm that the

communication is being secured

Activating the 1.

software

Open the software by
selecting DS_Wave.exe
from the startup menu.

|_? Help documentation
:_"j Uninstall DS_Wawve
] USBDRV Install

Select Communications — Communications  Language
Ports Settings from the

ports—settings

menu or click the Ports- Getbats  Cuith
settings icon on the =
Toolbar.

Make sure that USB connection is being
selected. The baud rate, stop bit, data bit, and
parity settings are fixed.

Corkect uzsing:

]

= Settings

Bitz per zecond: m
Data bits: m
Paiity: m oK

Stop bits: m Cancel

Defaults

Hal
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Activating the
GDS-122

1.

Power up the GDS-122 and activate the
oscilloscope screen.

Connect an input signal to CH1 and make sure
that the waveform is shown appropriately on
the GDS-122 display.

Open the DISP SET menu and press F4 (Carry)
to select the format of the waveform data sent
from the GDS-122 to the software.

Q Vectors
Bitmap

@ (7

N

Vectors Vectored data of the waveform.
Always select the vector format when
viewing the waveform in the software.

Bitmap Bitmap image of the display. Select the
Bitmap format only when taking the
bitmap snapshot of the GDS-122
hardware screen.

Connecting the
cable

1.

Connect the GDS-122 to the PC (software) via
the USB cable.

Make sure that the USB driver is installed in
your PC by accessing the Device Manager
(Control Panel -> System -> Hardware tab). The
GDS-122 should be recognized as a USB hub.

Ei" USE (Universal Serial Bus?

‘% oscilloscope ush Board '

If the driver has not been  [[# ps wave.exe
TECOgnized, install it I# Help documentation
manually by selecting (2} Uninstall DS Wave
USBDRV Install from the [FlE iy
startup menu.

The driver file is located in the USBDRYV folder
in the software directory.
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Acquiring data  In the software, select Cormrmunications  Language
Communications — Get Data ports=settings
from the menu. Alternatively, EEESEEE

you may click the Getdata g
icon, or press the Ctrl + A =
key.

Acquiring the GDS-122 display snapshot

When the “Bitmap” format is selected in the GDS-
122 display carry setting, the software acquires the
display snapshot (*.bmp) at the moment. Save the
file in the local folder and use a graphic software
to open and edit it.

Acquiring the GDS-122 waveform

When the “Vectors” format is selected in the GDS-
122 display carry setting, the software acquires the
waveform data (*.bin) at the moment.

1. The waveform data will be stored in the PC
memory to allow to be recalled later (page79).
Edit the location and click Start.

w. Fils rsceive from LUSB ...

Receiving: |DD7DEDEH 339 bin

— (|: Progam FleD5_WeVESatD 0703031 339 bin Brows..
File [ [ [

[F7roganm e/ O/ WAVE e/ DR 025 17 6m fosizz

Connecting the GDS-122 to the software is completed
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Configuring the screen

Overview This section introduces how to configure the
following parameters in the software screen
(waveform viewing mode) to optimize the user

interface.

e Background color o Drawing format

o Grid color o Language

o Grid on/off o Closing the software

Screen overview

Tool bar
& Icons

Types [None

Cursor type
ch2 TimeBase .
Horizontal
scale

Scale Position

2505 =] Albfe—

[~ch2 Voltage
Scale Position
200v_~ ﬁ
Waveform
I /1

. ch2

list Period:  0.82 mS
Frea:  1.213KHz
DD 200

Vertical scale

| Measurement
result

File
| ocation [e:/Program Files/DS/WAVE/Dat/D0610251417.bin [pos-122 Mo d e | name

Changing the To change the background color, [wiew |Fermat Gommi
background select View > Background Color ¥ Wave ¥T
color from the menu and select the Cata Table
new color from the color palette =~ _Grid Color
that appears. Alternatively, you =
can also double click inside the
screen to call the color palette.

Black background White background
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Turning the grid To turn on or off the grid, select [iew Fermat Commi
on or off View > Grid lines from the menu ¥ Wave ¥T
or click the Gridlines icon. Derie Telkle

Grid Celor
Background Color

v Grid lines

H
Grid on Grid off
Changing the ~ Make sure the grid is already View Format
grid color turned on. Select View > Grid v Wave YT
Color from the menu and select Data Table

the new color from the color
palette that appears.

Blue grid

Changing the You can select how the waveform is being drawn
waveform from two formats, line and dots. Select Format >
drawing format Data Line (Point) from the menu or click the icons.

Line Point

Format Co Format Co
Data Line
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Changing the  You can select the language from English (default)

language or Simplified Chinese. Select Language > English
(Chinese) from the menu. The Language menu
itself always stays as English.

English Chinese
Langusge He Languagse —'
v English English
Chinese v Chinese

chl TimeBase — [~ chl KFHLil

Scale Position 2= fiig

[foous = K2l [[soous =ik
Closing the You can close the software in one of the following
software ways. The screen configurations will be retained

the next time you open the software.

o DPressing the Alt + F4 keys

o Selecting File > Exit from the Eile = View Fon
menu Open
Page Setup..
Print Preview
Print...

Printer Setup

» Clicking the Close icon at the
top right corner of the software L= 0 E
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Viewing the waveforms

Overview This section introduces how to modify the
waveform settings for better viewings.
o Selecting the displayed waveforms
o Refreshing the waveforms
o Selecting the active waveform
o Changing the waveform positions
o Changing the waveform scales

o Viewing the automatic measurement results

Screen overview

Types [Nore =
CH2: ch2 TimeBase

Scale Position

25005 = ]2 femt—

ch2 Valtage

Horizontal
scale

Scde  Postion
L]

=i
Waveform _ ([ s mm =

Period:  0.82ms |
list e Fea 1213k Measurement

PK-PK: 2960V result

[pos-122

— Vertical scale

[e:7Program Fies/DS/WAVE/Dat/D06 10251417 bin

Active waveform

Selecting the In the left bottom corner of the screen, put a
displayed checkmark in the waveform that needs to appear.
waveforms Maximum six waveforms are available: CH1, CH2,

A, B, C, D. Waveforms A to D have to be stored in
the GDS-122 hardware beforehand (see page54 for
details).

(CHT1, CH2 selected)

250uUs 2.00%

Ca 5 ns 2.00mi i1
Oe 5 ns 2.00my i1
Oc 5 1S 2.00mYy i1
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Refreshing the  In the software, select Communications  Langt
waveforms Communications — Get Data ports—settings

Get Data

from the menu. Alternatively,
you may click the Get data icon,
or press the shortcut keys, Ctrl +
A.

Selecting the Waveform scale settings and automatic
active waveform measurements are done on the active waveform.

1. Click on the waveform name in the bottom left
corner of the screen.

(CH1 selected as the active waveform)

23005 2.00%

) 5 ns 2.00m i1
Oe 5 NS 2,00 i1
Oc 5 ns 2,00 i1

2. The following locations changes into the
selected channel (example: CHI).

¢ Colored channel label (at the -.

left side of the screen)

e Cursor, Time base, Voltage r-chl Cursor
settings (at the right side of

the screen) j-chl TimeBase ——

rchl Wioltage

. chi————————
« Automatic measurement Period:  0.82 mS

results (at the bottom right Freq:  1.213KHz
corner of the display) PK-PK: 13,200V

Changing the Changing the horizontal position

waveform 1. Move the mouse over the waveform until the
positions mouse icon changes into a left-right arrow.
1> (e
\ - w«
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2. Hold the mouse and drag the waveform
sideways.

1= =
> - <>

Changing the vertical position

Click the channel label at the left side of the
waveform and drag the waveform up or down.

N
— K

Changing the
waveform scales

Before changing the scales, make sure that the
correct waveform is selected (highlighted) in the
lower left corner of the screen (example: CH1I).

25005 5.00 Y i1
ch2 25005 200 i1
A 5 ns 2.00my i1

Changing the horizontal scale

Select the horizontal scale using | &t Timease
the list at the right side of the Sicale Position

screen. You can select the scale | 258 2]
either by searching in the Scale

column or by clicking the “
Position arrows. ifion

Pos Pos Pos
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Changing the vertical scale

Select the vertical scale using cht voltage

the list at the right side of the Scale POSiU'CiI
screen. You can select the scale

either by searching in the Scale =
column or by clicking the 100 Y
Position arrows. 1200V

Scale Pos Scale Pos Scale Pos

Viewing the
automatic
measurement
results

74

Before viewing the measurement results, make
sure that the correct waveform is selected
(highlighted) in the lower left corner of the screen
(example: CHI).

2300U5
[wch2 250u5 2,00 i1
Oa 2 n3 2.00mY i1

The measurement result -chil
is updated in the lower Period: 0582 mS

right corner of the Freq: 1,213 KHz
screen. Three parameters | gy s 43 507y
are listed. : :

o Period: measures the waveform period in ms.

» Freq: measures the waveform frequency in
kHz.

« PK-PK: measures the peak to peak voltage in V.
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Using the cursor measurements

Overview This section introduces how to use cursor
measurements in the software screen.
o Activating the cursors
» Viewing the cursor measurement results

» Moving the cursors

Screen overview

Vertical cursor

File View Format GCommupications Language Help

=k a| BB Hs L@

vizsss v I Measurement

v2: 444 %
result

e 1,200.00

x1: 30000 uS

Horizontal X2 210000 1S
cursor Types [ A=

— Cursor type

ch2 TimeBas
Scale Position

Fos =] 4l

ch2 Valtage
Scale Position

poov = j‘

chz
Period:  0.82mS

; Ssz\\// Freq: 1.213KHz
PK-PK. 2960V

2,00my
|c /Program Flles/DS/\WAVE/Dat/ D06 102514 17.bin Fns—uz

Activating the  Before activating the cursors, make sure that the
cursors correct waveform is selected (highlighted) in the
lower left corner of the screen (example: CHI).

[Wichz 25E|uS 2,00 1
A 3 nS 2.00rmv f1

Select the cursors from the list in the right side of
the screen.

+ None: the cursor is turned off. s

« Horizontal: the horizontal
cursors appear.

Types

« Vertical: the vertical cursors  qypes
appear.
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« All: both the horizontal and Types Im v|

vertical cursors appear.

Viewing the The cursor measurement ol Cursar
cursor results are updated in the dy 8.10
measurement  right side of the screen. vl 360 Y
results o dy: the voltage difference |%2: -4.50 W
between y1 and y2 cursors
. ke 250,00
* y1, y2: voltage cursors 1 x1 25000 WS
and 2 X2 50000 uS
o dx: the time difference
between x1 and x2 cursors | Types Im
e x1, x2: time cursors 1 and 2
dx
0. Os x1 X2
Moving the Move the mouse over the cursor until the mouse
cursors icon changes into a left-right arrow. Hold the
mouse and drag the cursor sideways (horizontal
cursor) or Vertlcally (vertical Cursor)
The cursor measurement result Changes
accordingly.
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Saving waveforms

Overview

You can save the waveforms into the PC in two
ways. For details of recalling them, see page79.

o Storing waveform data (*.bin file, for viewing
in the software)

» Storing data points (*.txt file, for data analysis
such as in graphs and maps)

For details of storing waveforms into the GDS-122
hardware, see page54.

Storing
waveform data

When retrieving waveform data from the GDS-
122, the waveform data (*.bin format) is
automatically stored. For details, see page69.

Storing data
point

1. Make sure that the waveform is being
displayed in the screen. To recall waveforms
that are stored in the PC, see page79.

2. Select View > Data Table from the | iiew Format
menu, or click the Data Table v Wave YT
icon on the Toolbar. The Data Data Table
Table dialogue appears. S

G o2l JAl IETED Jcii_Jpin =
w00 3440

500 3360 Units:(mv )
500 3440
500 3360
500 3440
500 3360 ~Save

ETR—T
IR
600 3440 P et
B o o .
FTR—T

- 2 Save option
R

-200 3360 Fc

500 3440 Fo
200 3360
500 3440
200 3280
-0 3440
200 3360

Save s +
-0 3440
Extt 1-

— Save data

200 3360
-0 3440
200 3360

ET—T 1]

+— Close window
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. Select the data to be saved from [ 3¢
the Save column. ol e
sequence: the identification | chi
number for each data point ¥ che
ch1l/ch2: CH1 and CH2 waveform | = &
data B
A/B/C/D: the waveforms stored W C
in the GDS-122 hardware ~ D
memory

GDS-122 User Manual

Data points stored in an Excel sheet (example)
sequence chl / ch2 A/B/C/D

Hﬂ\(a IR

1 |Units:{ mv' )

2 chl /1 |ch2/1 A Bi1 Ci1 D/
3 1 -600 3440

4 2 -600 3360

5 3 -600 3440

5} 4 -600 3360

. Click the Save As... button to
save the data into a directory. The = =aV€AS ...
standard Save dialog appears.

. To close the Data Point dialogue, do one of the

following actions.
Press the Ctrl + Alt key

Click the Exit icon
Exit

Click the Close icon at the top
right corner of the dialogue ’
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Recalling waveforms

Overview

You can recall the waveforms from the PC in two
ways. For details of saving them, see page77.

o Recalling waveform data (*.bin file, for viewing
in the software)

o Recalling data points (*.txt file, for data
analysis such as in graphs and maps)

For details of recalling waveforms into the GDS-
122 hardware, see page55.

Recalling the
waveform data

1. Select File > Open from the |File WVew Feormat (
menu or press the shortcut Open :
key, Ctrl + O.

2. The File Open dialogue opens. Select one of the
SPB bin file (*.bin) and click OK.

3. The waveform(s) will be recalled in the screen.

Language Help

\ Er©)

Types [fore ¥

ch? TimeBase

Scale Position

Pos =] D

[-ch2 voltage

Scale Posmiil
200V =] =
ch2

; Period: 0,82 mS
ooy // H Freq 1.213 KHz
Jome 1 o] | PKPK 2960V

[E:rPrograrm Fies/ D5/ WAVE/Dat/D0610251417.bin [pos-122

Recalling the
data points

1. For recalling the data points, you need to open
a text editor or a spreadsheet program like
Excel, in which you can organize the data and
create graphs and maps for advanced analysis.

2. Open the saved *.txt file from the application.
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Printing out waveforms

Overview

You can print out the screen contents to a printer
connected to the PC. When you are printing the
waveform for the first time, follow all the steps in
the following order.

1. Setting up the printer
2. Setting up the page format
3. Printing out

Setting up the
printer

1. Select File > Printer Setup File Wiew For
from the menu. The standard

printer setting dialogue Open

opens. Page Setup..
Frint Preview
Print...

Printer Setup

2. Select the printer and its properties, paper size,
and orientation.

Setting up the
page format

80

1. Select File > Page Setup from | Fjla \fiew For
the menu. The Page Setup
dialog window opens.

Open

Borderline Bardeline

Topt® =] Bottomigl 10 cm
Leftg? 1.0 cm  Right£? I 1.0 cm

View Setting=——_yia Setting

% Redraw graph according to sample data

" Graph zoom in and out

0K | Cancel | Default |

2. Set the borderlines (print margins). The range
is 0 to 10.0cm each.
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3. Select the View Setting.

Redraw graph according to sample data:

The GDS-122 refreshes the waveform and
adjust its scale before printing. The most recent
data can be taken, but might take time for
refreshing.

Graph zoom in and out

The existing waveform is used with its scale
adjusted. Since retrieving the data is not
involved, fast printing is ensured.

4. Open the print preview by File \iew For
selecting File > Print Preview
from the menu or clicking the
Print Preview icon on the
toolbar. Make sure that the
waveforms are placed

appropriately. @,

Open

FPage Setup..

Printing out

Print out the waveform in one of the following
ways.

o Selecting File > Print in the File Wiew
Print Preview screen menu Page Setup

o Selecting File > Print from the | File  \iew For

software menu O

Page Setup.
Print Prewisw

o Pressing the shortcut keys, Ctrl + P

» Clicking the Printer icon on =
the Toolbar =
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Accessing the Help

Overview The Help file describes how to install and use the
software. The About screen shows the software
version.

Opening the Open the Help in separate file using one of the

Help following methods.

o Selecting Help > Help from the | Halg
mend Help  F1

About

o Clicking the Help icon on the @
Toolbar

o Pressing the shortcut key, F1

o Selecting the Help documentation from the
startup menu

’ L’?_t’f_] DE_ave.exe

I? Help documentation
;’3 Uninstall DS Wawe

Software version

82

To view the software version, Help
select Help > About from the " Help F1
menu. The software version

screen appears.
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USING THE
MULTIMETER

This chapter describes the multimeter
functionalities in the GDS-122. Functionalities
includes three major items (Voltage, Current,
Impedance) and three additional items (Diode,
Continuity, Capacitance). The current
measurement and capacitance measurement use
extension modules to deal with large current and
small capacitance, respectively. Delta
measurement and automatic range switching
features offer flexibility and convenience.

Activating the Multimeter ......ccooviiiiiiiiiiieee 84
Measuring Voltage ..ccooeiuiiiiiiiii e 85
Measuring CUMTeNt ...t i e eaaes 87
Measuring Impedance ......coooiiiiiiiiii e 89
Measuring Diode ....ccooiiiiiiiii i 91
Measuring ContinuUIty ....oooiieii i i e 92
Measuring CapacCitancCe ....ccceviiiiiiiii it i eaaaas 93

83

GUWINSTEK GDS-122 User Manual

Activating the Multimeter

Panel operations 1. Press the power switch. The
welcome screen with the corporate
logo appears on the display.

2. To adjust display brightness, use =
the switch on the side: up (bright) T
or down (dark). =

3. Press any key (example: MENU  (Example)
key) to activate the display. The
battery icon at the top left corner of
the display shows the battery level.

> 75% 75% 50% 25% < 25%

P ®§ & 0 O

4. Press A (current), V (voltage), or R
(impedance, diode, continuity, -V
capacitance) switch to proceed. A
warning message might appear to R

remind you of correct connections.

NN oov B

(Press any key to make sure)

5. Press any key to cancel the warning message
and resume the measurement.
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Measuring Voltage

DC voltage Range 400mV, 4V, 400V

specifications A +(1% + 1 digit

(details: page98) ccuracy (1% igit)
Max input 400V

AC voltage Range 4V, 40V, 400V
specifications A +(1% + 3 digit
(details: page98) ccuracy (1% igits)
Max input 400V
Frequency 40Hz to 400Hz

Panel operations 1. Press the V switch to select the
Voltage measurement. If a warning ~ ya.
message appears, press any key to
resume measurement.

2. The voltage measurement screen appears.

Battery level — —— Run/Stop
Auto/Manual J -83.60mv Delt
elta
range ;— measurement
result
DCV/ACV —
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu —

3. Press the AUTOSET key

repeatedly to select DC or AC
voltage measurement.

4. Connect the test leads to the (black) & (red)

terminals: 4
COM for the black lead Am,;;
V/Q/C for the red lead CcoM v/Q/C

5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.
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Auto ranging

To let the GDS-122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of

the display changes to AUTO.

Manual ranging

To select the voltage range manually,
press F1 (Manual). The indicator at the ()
top left corner of the display changes @D
to MANUAL.

Freezing the
measurement

To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

IHE@%

Measuring delta
voltage

1. Press F2

o

To measure the delta value, press F2
(II/A). The measurement result at the
moment moves to the top right corner

of the display, and the measurement

result becomes the difference between

the original result.

2. Measurement 3. Delta value
reset to zero displayed

|
oov o
0 200.0v

o~
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Measuring Current e
- ma
o by F1 (Manual). The indicator
DC current Range & 40mA =+ (1% +1 digit) at the top left corner of the
specifications Accuracy 400mA *£(1.5% + 1 digit) display changes accordingly.
(details: page98) 20A %£(3% + 3 digits)
Max input 400mA (direct input) Measuring 1. Connegt the Current
20A (via the extension module) 400mA to 20A Extension module to the
COM & mA/A terminals. ! '
AC current Range & 40mA *(1.5% + 3 digits) & Then, connect the test leads
specifications ~ Accuracy 400mA *=(2% + 1 digit) to the extension module. ; ’
(details: page98) 20A %£(5% + 3 digits)
Max input 400mA (direct input) (red)nnnn"nn(black)
20A (via the extention module)
2. Press F5 (20A) and select the 20A
Panel operations 1. Press the A switch to select the Ca) 20A range. The MANUAL
current (Ampere) measurement. If A range indicator activates.
a warning message appears, press (Auto range is not available)
any key to resume measurement. i
Freezing the To freeze the measurement, press the @
Battery level — L Run/Stop measurement RUN/STOP key. The measurement ‘
Auto/Manual Delta result will be retained and the
range ] | emaurement indicator at the top right corner of the
result display changes to STOP. To unfreeze,
DCAJACA = press the RUN/STOP key again.
Measurement
unit Measuring delta To measure the delta value, press F2
Meter — Scaling factor current (II/A). The measurement result at the
Measurement moment moves to the top right corner
 result of the display, and the measurement
result becomes the difference between
F1-F5 menu — the original result.

1. Press F2 2. Measurement 3. Delta value

2. Press the AUTOSET key @ reset to zero displayed
repeatedly to select DC or - m 5 |
L
20.0mA

AC current measurement.

Measuring OmA 1. Connect the test leads to the (red) (black)

to 400mA terminals: @ jahy @
COM for the black lead MAX
mA/A for the red lead mA /A< com

If the range is set at 20A,
press F4 (mA) and change it ()
to mA range.

20A—>mA
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Measuring Impedance

Impedance Range &
specifications Resolution
(details: page98)

400Q +(1% + 3 digits)
4k, 40k, 400k, 4MQ. = (1% + 1 digit)
40MQ +(1.5% + 3 digits)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* QyC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the impedance
measurement.

3. The impedance screen appears.

Battery level — — Run/Stop

Auto/Manual _|
range

Delta
measurement
result

Impedance

Measurement
unit

Meter — Scaling factor

Measurement
result

F1-F3 menu

4. Connect the test leads to the (black) (red)
terminals: 4%_ @
COM for the black lead Am/?
V/Q/C for the red lead oM MBS

5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.

Auto ranging To let the GDS-122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of

the display changes to AUTO.
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Manual ranging To select the voltage range manually,

press F1 (Manual). The indicator at the
top left corner of the display changes
to MANUAL.

Freezing the

measurement

To freeze the measurement, press the

RUN/STOP key. The measurement
result will be retained and the

indicator at the top right corner of the

display changes to STOP. To unfreeze, $
press the RUN/STOP key again. STOP

Measuring delta To measure the delta value, press F2
impedance

90

1. Press F2

120.0kO

(II/A). The measurement result at the
moment moves to the top right corner

of the display, and the measurement

result becomes the difference between

the original result.

2. Measurement 3. Delta value
reset to zero displayed

2
&3 7
RN
\\’_ ___‘___-/,/
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Measuring Diode

Range 0V to 1.5V

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* QyC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the diode measurement.

3. The diode measurement screen appears.

Battery level — —— Run/Stop

Manual range —

Diode —
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu
(not used)

4. Connect the test leads to the (black) & (red)
terminals: v @
COM for the black lead 400V
V/Q/C for the red lead coM via/c

5. The measurement result will be constantly
updated in the display.

Freezing the To freeze the measurement, press the
measurement RUN/STOP key. The measurement @3
result will be retained and the
indicator at the top right corner of the

display changes to STOP. To unfreeze, $
press the RUN/STOP key again. STOP
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Measuring Continuity

Conditions <5002 (beeping)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* QY C
resume measurement.

2. Press the AUTOSET key repeatedly

to select the continuity
measurement.

3. The continuity measurement screen appears.

Battery level — — Run/Stop
Manual range —
Continuity
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu
(not used)

4. Connect the test leads to the (black) A (red)

terminals: Ay @
COM for the black lead e ﬁ)&"? —
V/Q/C for the red lead v/Q)

5. If the GDS-122 confirms continuity (the
impedance is less than 50€2), the beeper
sounds.

Freezing the To freeze the measurement, press the @
measurement ~ RUN/STOP key. The measurement ‘
result will be retained and the
indicator at the top right corner of the

display changes to STOP. To unfreeze,
press the RUN/STOP key again. STOP
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Measuring Capacitance

Continuity
specifications

Range 51.2nF to 100uF % (3% + 3 digits)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /¥ yC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the capacitance
measurement.

3. The capacitance screen appears.

Battery level —f

Auto range ——J

Capacitance

Meter

F1-F3 menu
(F1, F3 not —
used)

Py —— Run/Stop

1.360nF
i Delta
g — measurement
result
Measurement
unit

Scaling factor

Measurement
result

Measuring 5nF
and above

Connect the test leads to the CX cami
terminals. 400V cx

I

Measuring less
then 5nF

/N

Connect the Capacitance &
Extension module to the COM @ 200V— @
& V/Q/C terminals. Then,
connect the test leads to the
extension module. The
measurement result will be
constantly updated in the
display.
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Freezing the
measurement

To freeze the measurement, press the @
RUN/STOP key. The measurement ‘
result will be retained and the

indicator at the top right corner of the

display changes to STOP. To unfreeze,
press the RUN/STOP key again. STOP

Measuring delta

capacitance

1. Press F2

To measure the delta value, press F2
(II/A). The measurement result at the
moment moves to the top right corner

of the display, and the measurement

result becomes the difference between

the original result.

2. Measurement 3. Delta value
reset to zero displayed
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Faq

Power

Q

o The GDS-122 does not power up.

» The GDS-122 stopped working after a short
period of time.

The battery may need recharging. Connect the
GDS-122 to the AC adaptor and recharge it for
at least 15 minutes. Then try powering up.

ERR mode in the
multimeter

Q

In the multimeter mode, the measurement
type at the top of the display says “ERR”
which looks like an error message.

The “ERR” sign appears when none of the
measurement switch is pressed. Select one
from the V, A, or R switch and press it.

Amplitude
mismatch in the
oscilloscope

The measured voltage is 10 times smaller than
the real value.

The attenuation ratio on the probe is set at x10.
If you switch it to x1, make sure that the input
voltage does not surpass the maximum 400V.

The measured voltage is 10/100/1000 times
larger than the real value.

The probe ratio in the CH1 or CH2 setup
menu is set at X10, X100, or X1000. See page22
for details.

Unstable
waveform in the
oscilloscope

The waveform appears in the display but is
not stable.

Configuring the trigger might help you. See
page30 for details.

« Make sure the trigger source channel
matches the input signal.

o Make sure the correct trigger type, edge or
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video, is selected.

» Try changing the HF and LF repression in
the trigger coupling mode and filtering out
high or low frequency noise.

No waveform in Q
the oscilloscope

A

The waveform does not appear at all in the
display.

o The trigger level might be out of the
waveform range. Press the AUTOSET key
so that the GDS-122 automatically adjusts
the trigger level.

« If the trigger mode is Single, press the
RUN/STOP key to trigger the waveform or
switch the trigger mode to Normal. See
page30 for trigger details.

Slow update in  Q
the multimeter

A

It takes 30 to 40 seconds for the multimeter to
update the capacitor measurement.

It takes longer time to measure small
capacitors. 30 to 40 seconds are normal for
measuring 5nF or smaller capacitors. See
page93 for capacitance measurement details.

Slow update in  Q
the oscilloscope

A

96

The display response to the waveform change
is unusually slow.

Slow response is normal in the following

cases.

» Average sampling mode is being selected
(page22)

« Display persistence is being selected
(page36)
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SPECIFICATIONS

Conditions for  The following specifications are applicable when
specifications these two conditions are met:

o The GDS-122 has been powered up for at least
30 minutes, during which temperature
fluctuation is no more than 5 degrees Celsius.

o The probe attenuation is set to X 10.

Oscilloscope specifications

Sampling Mode Normal, Peak detection, Average
Rate 100 MSa/s
Input Coupling DC, AC
Impedance 1MQ=+2% in parallel with 20pF+3pF
Probe 1X, 10X, 100X, 1000X
Max. Input 400V (peak)
Channel delay 150ps (typical)
Horizontal Sampling rate 10S/s~100mS/s
Interpolation (sin x) /x
Record length 6K points on each channel
Scanning speed 5ns/div~5s/div, 1-2.5-5 step
Sampling rate / +100ppm (time interval = 1ms)
relay time accuracy
Interval (AT) Single: (1 interval time +100ppm X
accuracy (full reading+0.6ns) Average >16 : +(1
bandwidth) interval time +100ppm Xreading+0.4ns)
Vertical A/D converter 8 bits resolution (2CH simultaneously)
Sensitivity 5mV/div~5V/div (at input)
Displacement +50V(500mV~5V),=1V(5mV~200mV)
Bandwidth 20M
Single Full bandwidth
Low frequency >5Hz (at input, AD coupling, -3dB)
Rise time <17.5ns (at input, typical)
DC accuracy +5% (DC gain)

DC accuracy (avg) Avg >16: £(5% rdg + 0.05 div) for AV
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Trigger Sensitivity CH1 and CH2: 1div(DC~full bandwidth)
DC coupling: = 50Hz.
Trigger level +6 divisions from the screen center

Level accuracy
Displacement
50% level setting
Trigger sensitivity
Signal system

+0.3 div (typical, rise/fall time > 20ns)
655div (pre-trigger), 4div (post- trigger)
Input signal frequency > 50Hz (typical)
2 div of peak-to-peak (video trigger)
NTSC, PAL, SECAM (any frequency)

Measurement  Cursor AV and AT between cursors
Automatic Peak-to-peak, average, root mean
square, frequency, and cycle
Probe 1X position 10X position
Bandwidth < 6 MHz (DC) Full bandwidth (DC)
Attenuation rate 1:1 10: 1
Compensation 10pf~35pf 10pf~35pf
Input impedance 1MQ 2% 10MQ +2%
Input impendence 85pf~115pf 14.5pf~17.5pf
Input voltage 150 V DC 300V DC
Multimeter specifications
VDC Input impedance  10MQ
Max input 1000V (DC or AC peak-to-peak value)
Accuracy +1%+1 digit
Resolution 400mV range: 100uV
4V range: 1mV
40V range: 10mV
400V range: 100mV
VAC Input impedance  10MQ
Max input 750V(AC, virtual value)
Frequency range = 40Hz~400Hz
Display Virtual value of sine wave
Accuracy +1%+£3 digits
Resolution 4V range: 1TmV
40V range: 10mV
400V range: 100mV
DCA Accuracy 40mA range: =1%+1 digit
400mA range: £1.5%+1 digit
20A range: +3%+3 digits
Resolution 40mA range: 10uA
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400mA range: 100uA
20A range: 10mA

ACA

Accuracy

Resolution

40mA range: +1.5%+ 3 digit
400mA range: +2 %+ 1 digit
20A range: +5%+3 digits
40mA range: 10uA

400mA range: 100uA

20A range: 10mA

Resistance

Accuracy

Resolution

400Q range: +1%+3 digits
4kQ~4MQ range: =1%+1 digit
40MQ range: £1.5%+1 digit
400Q range: 0.1Q

4kQ range: 1Q

40kQ range: 10Q

400kQ range: 100Q

4MQ range: 1kQ

40MQ range: 10kQ

Capacitance

Accuracy
Resolution

+3%+ 3 digits
51.2nF range: 10pF
512nF range: 100pF
5.12uF range: 1nF
51.2uF range: 10nF
100uF range: 100nF

Diode

Reading range

0V~1.5V

Continuity

Threshold

General specifications

< 30Q

Display Type 3.8" color liquid crystal display
Resolution 320 (horizontal) X240 (vertical) pixels
Color 4096 colors
Power Consumption < 6W
Supply 100V~240V AC, 50/60Hz
DC input 8.5VDC, 1500mA
Environment Operating Temperature: 0 to 40 °C(32 to 104 °F)
Relative humidity: < 75%
Storage Temperature: -20 to 60 °C(-4 to 140 °F)
Relative humidity: < 75%
Mechanical Dimension 18 cmx11.5cmx4cm
Weight 6909
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DECLARATION OF
CONFORMITY

We

GOOD WILL INSTRUMENT CO., LTD.

(1) No.7-1, Jhongsing Rd., Tucheng City, Taipei County, Taiwan

(2) No. 69, Lu San Road, Suzhou City (Xin Qu), Jiangsu Sheng, China
declare, that the below mentioned product

Type of Product: Handheld Digital Storage Oscilloscope & Multimeter
Model Number: GDS-122

is herewith confirmed to comply with the requirements set out in the
Council Directive on the Approximation of the Law of Member States
relating to Electromagnetic Compatibility (89/336/EEC) and Low Voltage
Directive (73/23/EEC).

For the evaluation regarding the Electromagnetic Compatibility and Low
Voltage Directive, the following standards were applied:

© EMC

EN 61326-1: Electrical equipment for measurement, control and laboratory
use — EMC requirements (1997 + A1:1998 + A2:2001 + A3:2003)

Current Harmonics

EN 61000-3-2: 2000 + A2:2005

Voltage Fluctuations
EN 61000-3-3: 1995 + A1:2001

© Safety

Low Voltage Equipment Directive 73/23/EEC
Safety Requirements

IEC/EN 61010-1: 2001 (2nd Edition)
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ACA multimeter

video trigger source
contents of package
continuity, multimeter

AC-DC adaptor

ACV multimeter

addition, math mode cursor measurement

impedance multimeter
voltage multimeter
auto trigger mode
AUTO trigger status
automatic measurements .

cycle rms, automatic measurement 41
data point, storing ....
data table, PC software

capacity multimeter
continuity, multimeter
diode, multimeter
impedance measurement
voltage multimeter
average acquisition mode

DCA multimeter

DCV multimeter

default settings

delta measurement
capacitance multimeter
current multimeter
impedance multimeter
voltage multimeter

diode measurement, multimeter

background color, PC software
capacitance measurement,

carry, interface setting

acquiring snapshot

caution symbol brightness adjustment
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normal mode.
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ERR mode, multimeter ..................... 95
extension module

capacitance multimeter................ 93

current multimeter...................... 88

package ..., 10
factory settings........cccoevvvvcerrinnnennne. 53
FAQ . 95

ERR mode, multimeter. .95

magnification .............. .95

no waveform . .96

POWETING UP ...ovnvrieriirieiiaiaes 95

slow update, multimeter............. 96

slow update, oscilloscope............ 96

unstable waveform...........c.......... 95
field trigger, video.......cccceevvvrinnnnnce. 34
freezing measurement

capacitance multimeter................ 94

continuity multimeter.................. 92

current multimeter . .88

diode multimeter.........c.ccccocueuuee. 91

impedance multimeter ................ 90

voltage multimeter..............c........ 86
frequency, automatic measurement41
front panel overview..........ccccoceuuue. 12
grid color, PC software...........ccc...... 69
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grid, PC software..........ccccocveuviurunines 69
ground symbol...........ccoeviriniiinnnnn 6
help, PC software .........cccccvuvicunnnee 82
HERJC v 32
horizontal
adjusting position................... 20, 25
adjusting scale.......cc.cceceueruene 19, 26
scale vs trigger status................... 28
short cuts................ ...58
specifications.. .97

system status......... .37
impedance, multimeter..................... 89

specifications..........cccovuecuvceeininnnes 99
installing PC software........c.ccccocoeuuee 62
inverting channel...........ccccoovvennnnee 24
language

PC software ........cccoevvueeuniunrcnnnnes 70

ShOTt CULS...ocvveieieie 58
LE RJCooiiiiiieinninieisiisciesiienisaenans 32
line data, PC software... .69
line trigger, video .......c.ccoovnurierncnnes 34
list of features..........ccceevvveeuniciecuecnnns 11
magnification, vertical ...................... 25
manual ranging

current multimeter...........c......... 88

impedance multimeter ................ 90

voltage multimeter...................... 86
manual, overview of .........cccccceeveuas 14
math mode............... .39

shortcuts... .57

system status .......ccceeveriiieiinnnns 38

mean voltage, auto measurement... 41
multimeter

activating ........ccoovveeeeiininicne, 84
capacitance measurement........... 93
continuity measurement ............. 92
current measurement.................. 87
diode measurement...................... 91
ERRmode ..o, 95
impedance measurement............ 89
specifications...........ccceueuecurierininns 98
voltage measurement................... 85
Warning message.........ocovoveueueuenns 84
multiplication, math mode .............. 39
noisy signal, viewing ...........cccccceeuue. 49
normal trigger mode..........cccoeuvunnnne 32
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operation environment............ccec...... 7 calibration........cccoeeuevvicriicicincnnnes 52
OSC option Key ......ccccvvvriviiniirinnnnns 60 Package ..o 10
oscilloscope setting attenuation..........cccceeeuuee 17
specifications..........ccveveicecirennnens 97 specifications........c.ccvcviviiiicnnnas 98
switching to multimeter.............. 16 Ready trigger status..........cccceuvuenee. 27
package contents...........ccocevruriinnnn. 10 recalling
PC software default settings.........cc.oeevuvrrriunnne 53
activation ......cceeveeveeveeeereeeeeenenn 65 default settings, shortcuts............ 58
cursor measurement .... .75 waveforms from GDS-122.... 55
help ..o .82 waveforms, PC software .. 79
installation ... .62 resetting trigger level... 29
OVEIVIEW oottt 61 TUN tHZZeT .ot 28
PaCKage ... 10 sample acquisition mode.................. 35
printing out.......ccceveeveveiereccrennnens 80 saving
saving waveform...........ccccoeeeueee 77 ShOTtCULS ..o 59
SCIeen OVEIVIeW .........cccceveeeeverecnens 68 waveforms in PC software.......... 77
uninstall ... 64 waveforms inside GDS-122 ........ 54
VEISION...uveiirvieiierieietie e 82 scale
viewing waveforms..........c.c......... 71 horizontal.........cccccvviviniciricnnnnne. 26
peak detect acquisition mode.......... math mode.. 40
application........cccccveeciriciinicnnes vertical ..., 23
period, automatic measurement..... 41 waveform, PC software............... 73
persistence setting ............cceueevennenen. 36 XY MOAE....oieiiiciiiiiieicieiiaes 47
application ........cccccevciecinieieienias 50 ZOOM...ouviieiierrenseresie st ses 46
pk-pk voltage, automatic Scan trigger status ........ccccoeeeveinenenne. 27
Measurement........coceveeevreeuevcnnns 41 self calibration..........ccoeveevviieciiincnnns 51
point data, PC software................... 69 SET1/2, automatic measurement..... 41
position signal peak, viewing ...........c.cccocc.... 48
horizontal........ccooerieinieinicn, 25 single trigger mode .. 32
math mode... .40 slope, trigger........... 30
shortcuts.... .60 snapshot, display ... 67
HMe CUTSOT .....cvieerierieiieiiiae 43 software Version ..........ccccceeeueeunnes 82
HIGEeT vt 28 specifications
vertical......cooveniciicce 23 general......coovvcnenicinic 99
voltage CUrsor........cooovevvincueincnnn. 44 multimeter ... 98
waveform, PC software............... 72 oscilloscope........ccoevviiiriiciiinnnn 97
XY MO 47 StOp trigger ....ovvveeccieieee 28
power supply STOP trigger status .......cc.ceeevvvrunnnee. 27
safety instructions ............cceeeunnee 7 storage environment .............cceevueune. 8
specifications... . subtraction, math mode......... 39
POwWer up, faq....ccoeeveivcireininiciinnns synchronization, video trigger-........ 34
POWETING UP ..o system status .........cocoeeveeeerireieieinnns 37
print out, PC software..........cccceou.e 80 ShortCutS....ceveveevereeceveeeeeeeeee 59
probe testlead ..o 10
adjusting display magnification 17 threshold, continuity multimeter.... 92
adjustment toOl .......cccccvvurvurinnnnns 10 tilt stand ... 17
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time cursor.........cooueve....
Trig'd trigger status......
trigger
adjusting level..........
auto mode................

specifications............
status icons ...............

UK power cord.......ccoouueieiirinruninninnae. 8

USB driver installation
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variations, Viewing...........c.cceeveunen. 50

vector drawing.........ceveveiececiiincnenns 36

vertical
adjusting position................... 20,23
adjusting scale........c.cccocvuenunne 19,23
inverting channel............cccccc.c.... 24
selecting coupling mode.............. 24
selecting magnification................ 25
shortcuts.......cocvvuenee ...56
specifications.. 97

system status..
video trigger .......cooveveereicrevcnnne. 33
field trigger.....ccovuvivvrivcrrcininnnes 34
line trigger ......ccoevvevvecrevcerennen 34
source channel .........cccccooeeeinnnees 34
SYTIC cvvtverecrerentesssese s seeaens 34
voltage Cursor........c.coouoeuveueeunienicnnnnns 43
warning message, multimeter......... 84
warning symbol..........ccccooeerirninnnes 6
xy mode......... .47
system status .......cccoeevrieiiniicnnns 37
zoom waveform...........coeeeenecins 45
system status .......cccceeeieiinnnnnns 37
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